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1. Introduction

1. Introduction

1.1 How to use this manual

This user manual is divided into four sections which cover the Introduction, Overview,
Operation, and Troubleshooting. Please study this manual carefully before installation,
and use the printer according to these instructions. Keep this manual handy and refer
to it when necessary.

Some great websites to help you on your way.

®  htp://www.pp3dp.com/forum

® hiip://cloud.netfabb.com/ STL file cleaner

® hitp://www.thingiverse.com/ lots of STL models

®  hitp://www.3dcontentcentral.com lots of 3D models

®  hitp://www.cadspan.com/tools free plugin for Sketchup

®  hitp://3dprinting.co.nz/australia-new-zealand-3d-printing-systems/3d-printing-with-google-sketchup/ Sketchup & 3D Printing

1.2 Precautions

Please read this section carefully before using the printer.

1.2.1 Safety

@ The printer can only be used with the power adapters supplied with the printer, or
the product may be damaged, with a risk of fire.

€ To avoid burning, or model deformation, do not touch the model, nozzle, or the
platform by hand, or any other part of the body, while the printer is working or
immediately after it has finished printing.

€ Ensure the supplied warning stickers are attached to the printer in the relevant
places.

The following classifications are used in this manual.

CAUTION: Indicates a potentially hazardous situation which, if not
! avoided, may result in minor or moderate injury.
1 WARNING: Indicates a potentially hazardous situation which, if not
2 avoided, may result in serious injury.
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1. Introduction

Gloves: When performing certain maintenance procedures, the machine
may be hot and gloves are required to avoid burns.

|! Safety Glasses: Wear safety glasses to avoid injury to your eyes.

1.2.2 Protection

The printer must not be exposed to water or rain, or damage may occur.
Do not shut down the UP! Printer or pull out the USB cable when loading a
digital model, or the model data may be lost.

* o

When using the “Extrude” function, keep at least 50mm between the nozzle and
the platform. If too close, the nozzle may get blocked.

2

The printer is designed to work properly at an ambient temperature of between
15°C and 30°C and humidity of between 20% and 50%; Operating outside these
limits may result in low quality models.

€ Attach the supplied warning stickers to the printer.
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2. Overview

The UP! Printer is designed with ultimate portability and simplicity in mind. The
system and software allow you to print great models with only a few keystrokes, even
if you have never used a 3D printer before. The system uses a nozzle to deposit
molten plastic, so printed parts are strong and durable. Congratulations on purchasing
an UP! 3D Printer.

2.1 Appearance

Figure 1. Front view of printer

® @ ©®© @

©

@ Pedestal @ Platform

@ Nozzle @ Extruder

®) Filament tube ®) Filament supplier
@ ABS plastic Material spool

© Material spool holder
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2. Overview

Figure 2. Kit contents

_ | Platform adhesives @ Power adapter (20 V)

@ Tool set @ Power adapter (5 V) (no longer

included- a power fly lead is used instead)

@ USB cable & Filament tube @ Gloves

Figure 3. Tool set

@ Woodcut knife @ Tweezers

® Hexagon wrench @ Nozzle wrench & Nozzle
@ Shovel @ Screws

@ Brush Pliers
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2. Overview

Figure 4. Axis

@ Y axis -Extruder left and right
®) Z axis — up and down

@ X axis - Platform forward and back.
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2. Overview

2.2 Specifications

2.2.1 Printer Physical Characteristics

Printing Material

ABS Plastic

Material Color

White

0.20 — 0.40 or 0.25—0.35 mm,

Layer Thickness depending on model
Print Speed 10—100 cm’/h
Print Size 140x140x135mm
Printer Weight 5 KG (11 1b)

Printer Size

245 x 260 x 350 mm

2.2.2 Specifications

Power Requirements

100-240 VAC, 50-60 Hz, 200W

Model Support Auto-generated Support
Input Format STL
. ot Windows XP/Vista/Win7 — Mac
Workstation compatibility .
coming July 2011

2.2.3 Environmental specifications

Ambient temperature

15°C~30°C

Relative humidity

20%~50%
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3. Operation

3.1 Preparation

3.1.1 Installing the printer

Open the box and take out the printer and accessories.

Assemble the parts contained in the box as follows:
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1. Unscrew the M4 screw from the extruder, and fix the extruder onto the holder.
Please make sure the extruder is parallel with the Extruder axis. (Tool set includes the
M4 screw and Allen key)
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3.0peration

2. Install the ABS plastic spool holder. Unscrew the short M3 screw (M3X5) from the
printer, and then fix the spool holder with a long M3 screw (M3X8). Please note that
the spool holder should lock onto the printer’s corner.
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3.0peration

3. Install the filament supplier. Unscrew the short M3 screw (M3X5) from the printer,
and then fix the filament supplier with a long M3 screw (M3X8). Please note that the
filament supplier should lock onto the printer’s corner.
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3.0peration

4. Install the extruder cable (14-pin). Open the extruder upper lid and you will see a
14-pin socket. Connect the plug into the socket, and put the upper lid back on.
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3.0peration

5. Connect the power adapter to the printer.
Connect the power fly lead to the second socket and then to the auto feeder.

NOT USED!!!

Connect the large Power adapter (20 V) to the power cable, and connect the 4-pin
plug to the socket on the printer. Please note that the flat side of the 4-pin plug, which
is marked with an arrow, should be at the top.

Do not connect anything to the socket as shown in the picture above “Not Used!!!” If
it is not blanked out already, please do so.
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3.0peration

Connect the small supplied 5V power supply to the Auto Feeder. Please make sure the
cable is clipped onto the side of filament holder as shown.

Finally, connect the printer to a computer using the provided USB cable.
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6. Installing the Plastic ABS spool.

Warning: Do not uncoil or let go of the end of the coiled plastic, otherwise it will
tie it’s self in a knot and then eventually, during use, it will burn out the Auto
Feeder motor. If you have, try and uncoil the plastic manually and ensure there
are no knots it the roll of plastic!

Put the ABS plastic roll onto the holder, and thread the ABS filament into the feeder
and press the travel (indicated as red arrow) switch. The filament will automatically
feed material for as long as you hold down the switch.
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7. Insert the end of ABS filament into the Filament tube / straw. Press the feed switch
until the filament goes all the way through the filament tube, and about 10cm of
filament protrudes from the tube / straw.

Start the UP! Software (refer to the software install procedure in 3.1.2 if you have not
already installed it), and press the “Extrude” button in the “Maintain” dialogue box,
which is accessed from the “3D Print” menu. After the printer nozzle has warmed up
to 260°C, the printer will beep. Push the filament into the hole at the top of the
extruder head and hold it there with some gentle pressure until the extruder motor
grabs it and starts pulling it through the extrusion head. The extruder will then
automatically extrude a thin filament of material for approximately 30 seconds and
then beeps to advise extrusion is over.

Maintain---Printing

Matrials: 604 g Status:

Extrude | WithDraw | TNEw Spool‘ Makzdtz: LITC (HEETg)

Platform: 1.0C Heating

MNozzle & Platform
FL FR To: | | 128 EI: Stop Al

Center | To Battom |

ML TR Set to Nozzle Height Quit

.

8. Install the print platform. Raise the platform axis (by clicking TO in the maintain
window) to a height at which you can reach under it to insert the screws. Line up the
screw holes on the platform with the screw holes on the heater base and insert the
screws in from the bottom and tighten them.
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3.1.2 Installing the software

http://3dprintingsystems.com/3dprinterl.11.zip

Start the UP Setup.exe file and install it to the specified directory (Defaulted Program
files/UP). Note: This installs the UP software, the UP drivers, and the UP sample files
into your Program files(x86)/UP

- up
4 Driver
amdbd
i386
iab4
Example
System
Temp

3.1.3 Installing drivers

Connect the printer to a computer with the USB cable. The computer should pop up the
“Found New Hardware Wizard” window. Choose ‘“No, not this time”, and then “next”.

Found New Hardware Wizard

T Welcome to the Found New Hardware
\? Wizard

Biead our privacy policy

Can‘Windows connect to Windows Update to search for software?
(O)Yes. this time only

(7)es, now and every time | connect a device

(@) Mo, not this tims

ks

Click Mext o continue:

I Mexdt > 1 [ Cancel

Choose “Install from a list or specific location (Advanced)”, then “Next”.
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Found New Hardware Wizard

This wizard helps you install software for:

30Print@FrestC

\) l your hardware came with an installation CD or
floppy disk. insert it now.

What do you want the wizard to do?

) Install the software autarmatically (Recommended)
(@) Install frorm & list or specific location (Acvanced)

Click Mextto cantinue.

Mext >

J [

I < Back ” Cancel ]

Click “Browse”, and choose C:\Pro

gram Files\UP\Driver, then “Next”.

%]

Browse For Folder

Found New Hardware Wizard

Select the folder that containg drivers for vour hardware.

= ue
= :|§)I’IVE!I’
I System
1) Temp
+ |7 Web Publish
= ) Windows Live
) Windows Live SkyDrive

To view any subfolders, click a plus sign above.

I QK H Cancel ]

Please choose your search and installation options.

(8) Search for the hest driver in these locations.
Use the check boxes below to limit or expand the default search, which includes local paths and
removahle media. The best driver found will be installed

[ 1Search rermovable media flappy, CO-ROM..)
Include this location in the search
CHProgram Files\UR\Driver

n Browse

() Don't search. | will choose the driver to instal.

Choose this option to select the device driver from a list. YWindows does not guarantee that the
driver vou choose will be the best match for your hardware k

[ < Back ” Mext > Cancel

| |

|

The following dialogue box pops up. Choose “Continue Anyway”, and the drivers

will install automatically.

Hardware Installation

Found New Hardware Wizard

&

The software you are installing far this hardware:

3DPrint@FreehC

Please wait while the wizard installs the software...

K

IDPrint@FreeMC

b=

has not passed Windows Loga testing to verity its compatisility with

Continuing your installation of this software may impair or
destabilize the correct operation of your system either
immediately or in the future. Microsoft strongly recommend:
that you stop this installation now and contact the e
vendor for software that has passed Windows Loga testing.

Continue Anyway | [_STOP Installation

57}

IDPrintUSB.ays
To CAWINDOWS\System32\Drivers.

(
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3.0peration

.8 Free Motion Card
: L 30 Printer@FreeMotion |

Correctly Installed in Windows Device Manager.

3.2 Using the basic functions

3.2.1 Start the program

Click on the ==

New Features is V1.11

1. Update your ROM! Open the UP! software V1.11, select Tools ->
Update ROM -> Program file\UP\system \UP! plus_R_110513.ROM. When
updating completes, unplug the power supply then plug it back in.

2. Print PLA or ABS material. In the printing dialogue, select ABS or PLA as
printing material. The temperature for printing PLA is 200 centigrade; printing
ABS (as supplied) is 270 centigrade. The temperature will be fixed
automatically once material is selected each time.

3. No raft option. No raft option allows models being printed without raft
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4. FIX feature. Once STL model is opened using UP! software and there is Red
indicated on the model, this shows the model has facets problem. Most
problems can be fixed by the FIX option. If it did fix the model, the colour of the
model will go back to normal.

5. Merge several models into one. After several models are upload into the UP!
software, select merge option to merge several models into one.

6. Copy option. Open STL model using UP! software, click the right button to
insert 1-8 copies.

7. Save all. Save all the models together, just select File -> Save All, then all the
models can be saved at once. Format of saved model is .UP3, models can be
found in the folder where the original files are. Please note if several models are
in the same name, then only one model will be saved.

8. Optimize nozzle height setting. When the platform is very near the nozzle,
the distance between platform and nozzle is difficult to detect, just select “Set to
Nozzle Height”, then printer will print test lines semi-automatically, by checking
width of the printed test line the nozzle height can be set accurately.

3.2.2 Loading a 3D model

Click “File / Open” or on the toolbar and select the model you want to open. UP
supports STL files (which is the standard input format for 3D printing files), and the
UP3 format (which is UP’s proprietary compressed STL format)

Move the mouse pointer onto the model, and click the left mouse key. Some model
information is presented in a floating window, as shown below:

3D Model: ve

File: EA Ve

Facet:044  Vertex:d66
Vol:48.93(CM3)  Surface:213.00(CM2)
Size: 53.98 X 49.94 X107.00 mm

Min: -131.99 X -3.97 X 3.00 mm

Max: -78.01 X 45.97 X110.00 mm
Format: Binary

| BT | I N |

Tip: You can open several models and print them all at the same time. Just repeat the
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open model procedure for each model you want to add. See the “Placing models on
the build platform” section for more information.

Unloading the model: click the left mouse button on the model to select it, and then
click “Unload” on the toolbar, or click the right mouse button while over the model
and a context menu will appear. Choose unload the model or unload all models (if you
have more than one file open and want to remove all of them).

Unload all
Unload PIG

Saving the model: Choose the model, then click “Save”. The file is saved in UP3
format and its size is 12%~18% of the original STL file. This is a convenient format
for users to archive or transfer files.

3.2.3 View Options

To observe the target model in different ways, use the mouse to control the view.
Rotate: Press the middle mouse button and move the mouse: The view can be rotated
and observed from different angles.

Pan: Press Ctrl and the middle mouse button at the same time and move the mouse:
This causes the view to pan.

Scale: Rotate the mouse wheel: The view gets zoomed in or out.
View: The system has 8 preset standard views stored under the “View” button on the

toolbar. Click the View button on the toolbar (the startup value for the View
button is “Fit") to find these options:
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3.2.4 Model transformations

Model Transformation can be achieved through the Edit menu or the toolbar:

X Axis ¥ Axis Z Axis
Auto Placement X Axis Y Axis £ Axis

Moving the model: Click the “Move” button and choose, or input, the distance you
want to move in the text box. Then choose the axis (direction) in which you want to
move. Each time you click the axis button the model will move again.

For example: Move the model -5 mm along Z axis (or down Smm).
Procedure: 1. Click on “Move”; 2. Input “-5” in the text box; 3. Click the “Z axis”.

Rotating the model: Click the “Rotate” button on the toolbar, choose or input how many
degrees you want to rotate in the text box, then choose the axis to rotate around.

For example: Rotate the model around Y axis by 30°.
Procedure: 1. Click “Rotate”; 2. Input 30 in the text box; 3. Click “Y axis”.

Note: positive numbers rotate counterclockwise and negative numbers rotate clockwise.
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Scaling the model: Click “Scale”, choose or input a scaling factor in the text box, and
then either scale the model uniformly by clicking the scale button again, or choose the
axis around which you want to scale if you only want to scale in one direction.

Examplel: Scale up the model uniformly by 2.0 times.
Procedures: 1. Click “Scale”; 2. Input 2.0 in the text box; 3. Click “Scale” again.

Example2: Scale up the model by 1.2 times along the Z axis only.
Procedures: 1. Click “Scale”; 2. Input 1.2 in the text box; 3. Click “Z axis”

S o
move rotate | Scale

Unit Conversion: This option is provided as a convenient way to convert metric
models to imperial, and vice versa. To convert an imperial model to metric, select the
25.4 option from the scale menu and click “Scale” again. To convert from metric to
imperial, select the 0.03937 option and click “Scale”.

3.2.5 Placing models onto the build platform

Appropriately placing your models on the platform can have an effect on print quality.

Tip: In general, try to place your model in the centre of the platform.

Auto Place: Click the “Auto Place” button, on the far right of the toolbar, to
automatically place the model on the platform. When there is more than one model on
the platform, using “Auto Place” is recommended.

By Hand: Press the Ctrl key and choose the target model by pressing and holding the
left mouse button. Move the mouse and drag the model to the desired position.
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Using the “Move” button: Click the “Move” button on the toolbar, choose or input
the distance in the text box, and then choose the axis for the direction in which you
want to move.

Note: When more than one model is open, the gap between each model should be
kept to at least 12mm to prevent the models sticking together.

3.3 Getting Ready to Print

3.3.1. Initializing the Printer

Before anything can be printed, the printer must be initialized. Click the “Initialize”
option under the “3D print” menu. The printer will beep and the initialization
procedure will begin. The printer will then return the platform and print head to the
printer’s origin and beep again when it is ready.

3.3.2. Calibrating the Nozzle Height

To print successfully, the platform should be set to start at a distance of 0.2mm (the
thickness of a business card) from the nozzle. As each printer is slightly different, this
distance needs to be calibrated before starting to print. The correct distance between
the nozzle and platform is recorded in the “Nozzle” box of the “Setup” screen (found
under the “3D Print” menu, but we use the “Maintain” dialogue box to figure out what
this distance should be.
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Setting: LMP Printer, ¥1.0 - 108215

Frint
Predef:

Optimize:
Height

Basze: m [ Mozzle: |142.1 ]

2mrm ~
Part
Contour: Fill: | anse -
Surface: |3 | ayers ~
2 Llavers ¥

Angle<: |45peg

Support

Dense:

Angle<: |gp Deg -
Space: |glines v Area=! |5 mm2 -

Other
[~ Stable Support -

Restore Defaults | OK Cancel |

In the above example, this tells the printer that, after being initialized, the platform is
142.1mm away from the nozzle.

To figure out the correct nozzle distance, please follow these steps:

1 - Open the “Maintain” dialogue box from the “3D Print” menu.

Maintain---Printing

Matrials: 604 g Status:

Extrude | WithDraw | TNEw Spool‘ Makzdtz: LITC (HEETg)

Platform: 1.0C Heating

MNozzle & Platform

FL FR To: | | 123 EI: Stap Al

Center | To Battom |

ML TR Set to Nozzle Height Quit

2 - In the text box, type in the height to which you want the platform to move to, and
click the “To” button. In the above example, the platform would move to 128mm
above the platform’s origin.

3 - Check the distance between the nozzle and the platform. If, for example, the
platform appears to be about 4mm away from the nozzle, increase the number in
the text box to 131 and click the “To” button. Note that we have only increased the
number by 3mm instead of 4mm. The reason for this is that we do not want to
crash the platform into the nozzle, so we want to increase the height in smaller and
smaller increments as we get closer to the nozzle.
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4 - Once you are about Imm away from the nozzle, start increasing the number in the
text box by 0.Imm increments and click the “To” button. Repeat this until you get
to within 0.2mm of the nozzle.

TIP: An easy way to check the distance between the nozzle and platform is to fold a
piece of paper in two (Which will make it about 0.2mm thick) and use that as a
spacer to gauge the distance between the nozzle and platform.

5 - Once you are within 0.2mm of the nozzle, write down the number you have in the
“To” box. This is the correct calibration height! Close the “Maintain” window and
open the “Setup” Window. In the “Setup” window “Nozzle” box, enter the number
you recorded on the “Maintain” Screen. Alternatively, you can click the “Set to
Nozzle Height” button to automatically transfer the value across to the setup screen.
You have now successfully setup the nozzle height.

Note: Once you have setup the nozzle height once, you do not need to do it again
as it is automatically recorded in the ‘“‘Setup’ Screen.

TIP: You may need to recalibrate nozzle height after moving the printer, or if you find
the models are not adhering to the platform properly. If you keep adding new
green paint on top of the old green paint, you may also need to recalibrate your
nozzle height regularly.

3.3.3 Other Maintenance Options

Click “Maintain” on the “3D Print” menu, and the following dialog box pops up:
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Maintain---Printing

Matrials: 604 g Status:

Extrude | WithDraw | TNEw Spool‘ Makzdtz: LITC (HEETg)

Platform: 1.0C Heating

MNozzle & Platform
FL FR To: | | 128 EI: Stop Al

Center | To Battom |

ML TR Set to Nozzle Height Quit

Extrude: Squeezes material out of the nozzle. Click on this button, and the nozzle is
heated. When the temperature is high enough (260°C), the material is squeezed out of
the nozzle. The system beeps before material starts extruding, and it beeps again when
finished. When changing the material (See section 6), this function is used to deliver
the new material to the nozzle. This function can also be used to test whether the
nozzle is working correctly.

Withdraw: Withdraws the material from the extrusion head. When the material runs
out, or the nozzle needs to be changed, click this button. When the nozzle is up to
temperature (260°C) and beeps, gently pull out the material. If the material gets stuck,
pull it out it by hand.

New Spool: This is used so the printer can keep track of how much material has been
used, and warn you if you don’t have enough material left to print your model. Click
this button and enter the value of how many grams of material you have on the current
spool. If it is a new spool, the quantity should be set to 700 grams.

Matrials: 604 g Status:
Extrude New Spool 3] 1 0c Heating

i: 1.0C Heating

Mozzle & Platform WWeight: ’T gram

ﬂ B Stop All
,T' Cancel |

M m Set to Nozzle Height w

Tip: An empty spool weighs about 280 grams so, if you are installing a partially used
spool, weigh it, and subtract 280 grams from the weight. This gives you the value
to enter into the material text box.

Status: Displays the temperature of the nozzle and platform.

Stop All: Stops heating and all the movement of the printer. Once you click this
button, the current model being printed is cancelled. You CANNOT resume a print
job once the printer has been stopped.

UP! 3D Printer User Manual 29




3.0peration

Nozzle & Platform: The five buttons (FL, FR, Center, NL, NR) control the position
of the nozzle and the platform. The nozzle moves to the left and right; the platform
moves forward and backward.

The “To” button controls the height of the platform, and is used in the nozzle height
calibration procedure described in 3.3.2.

The “Bottom” button returns the platform to the lowest position.

Set to Nozzle Height: Takes whatever value you have in the “To” box and transfers it
to the Nozzle box of the setup screen.

3.3.4. Preparing the Platform

Before printing, the platform must be prepared so that the model adheres to the
platform enough to be printed without the model moving while, at the same time,
being easy to remove from the platform after printing. There are 2 options for
preparing the platform:

Method 1 - The Green Paint: This is a special adhesive paint that you need to paint
onto the platform. The platform should be painted with a thin and even coat of paint to
achieve best performance.

After several prints, you will find the paint starts to wear off, so the platform needs to
be regularly repainted. Note that if you repaint on top of old paint the paint thickness
will, eventually, build up to the level where you need to recalibrate your nozzle height.
The surface finish may also become uneven, which could affect print quality.

TIP: To clean off the old paint from the platform, leave the platform to soak in water
for a few hours and the paint will then easily peel off.

Method 2 - 3M Blue 2” Masking Tape: Many users have reported successfully using
the 3M 2” Blue Masking Tape instead of the green paint. Simply cover the platform
with a layer of 3M blue masking tape and print onto the tape. Replace the tape when it

UP! 3D Printer User Manual 30




3.0peration

wears out.

Method 3 — Electrical perfboard (Perforated electrical board) lying on top of the platform.
This should be cut at an angle so the perforations are at an

angle. http:/search.digikey.com/scripts/DkSearch/dksus.dll?vendor=0&keywords=V201
2-ND This is held on with tiny bulldog clips and make sure the clips have clearance!

3.3.5. Print Setup Options

Click menu “3D Print->Setup”. The following dialog box pops up:

Setting: LMP Printer V1.0 - 108215 X
Print
Fredef: | SERTaLON ~ Optimize:
Height
Base: - Mozzle: |142.1

Part

2mm
Contour: Fill: | gose -
Surfare: |5 avers - Angle<! 45 peg v
-
S mmz <

Support

Dense: |3 layers ~ Angle< |5n peg
Space: |z Lines - Areax:

Crther
I~ Stable Support r

Restore Defaults | oK | Cancel

Print Options

Predef: Sets the print resolution (layer thickness) of the printer. This can be between
0.2mm per layer to 0.4mm per layer (depending on the printer model).

Optimize: Disabled.
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Height Options

Base: This is the thickness of the raft of material before the support layer is printed
under the part. When the printer starts printing, it first prints a raft of non-solid
material in which all the lines of support material are horizontal (along the Y axis). It
keeps building up horizontal rows of support material for as many mm as you have
chosen. Then, just before it gets to the bottom surface of the real part, it starts to build
support layers perpendicular to the raft layers layer.

J(Parﬁ Support -
Q /(dense)\ - Part
8mm 2mm5

Support Raft Support Raft

The default value for this parameter is set to 2mm.

Nozzle: represents the distance between nozzle and the print platform when it is at the
bottom position. It is essential that this value be correctly set for good printing. See
section 3.3.2. for instructions on calibrating your printer.

Part Options
Contour: Disabled

Fill: There are four ways to fill the interior of the parts, including Solid, Loose,
Hollow, and Big Hole.

Solid The Part is made of solid plastic, which gives you the strongest part. This
setting is recommended for functional engineering parts.
Loose The part has an outer wall thickness of solid plastic (about 1.5mm), but

its interior is filled with a reasonably small scaffold structure

Hollow | The part has an outer wall thickness of solid plastic (about 1.5mm), but
its interior is filled with a medium spaced scaffold structure

Big The part has an outer wall thickness of solid plastic (about 1.5mm), but
Hole its interior is filled with a large spaced scaffold structure

o

4 ]éig Hole

Surface: This parameter determines how many layers form the bottom face of a part
when it is not solid. For example, if you set it to 3, the machine will print 3 complete
layers before going into non-solid mode. This does not, however, affect the side wall
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thickness on non-solid parts, which are all the same thickness (approximately 1.5mm)
irrespective of the fill mode.

Angle: The part Angle determines at what point solid (dense) support material gets
used. If the angle is small than the printer will add solid fill layers under the part
surface. The thickness of this solid (dense) support is determined by the “dense”
parameter under the Support options as described below.

Solid
Non-solid support

support / (dense)

| ¥—
- Non-solid support |

Support Options

Dense: This represents how many layers of ‘solid’ (dense) material form part of the
support structure directly beneath the model.

Angle: Angle at which support material gets used. For example if 10° is used, support
material only gets used if angle of surface is greater than 10° from horizontal (so
support material is almost not used unless there is a direct overhang), If set to 50° than
support material is used for any surface is greater than 50° away from horizontal.

Set to > 10° Set to > 50°
100 + ‘ ﬁiJ
—1 S 45° €

= 50°\( /| =
2 =)
%)
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There is always a delicate balance between
minimizing the amount of support material, versus
the quality of the part, versus the difficulty of
removing support material.

The orientation of the part on the print platform is
also critical in determining both how much support
material gets used, and also how difficult the
support material will be to remove.

As a general rule, it is easier to remove support
material from the outside of a part than from the s oo

inside. As can be seen in the picture to the right, '
the part would use a lot more support material if
printed with the opening facing downwards than if

it were facing upwards.

Little support material required

Space: The distance between the lines of non-solid support material. Changing this
parameter requires some experience in balancing the quantity of support material used,
ease of support material removal, and part print quality.

Support Structure 0.5 mm
> line space line width
EQ
IS. mm :
6 mm
v
6 lines 12 lines

Area: The surface area above which support material gets used. When you choose
5mm?, for example, there will be no support if the overhanging area is less than Smm’.
Benefit? A little material is saved and a slightly faster print speed is achieved.

Area < 5mm? Area > 5mm?
]

=S d ~Support

Other Options

Stable Support: Stable support creates support that is more solid, and the model is
less likely to distort, but the support material is then more difficult to remove.
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Link Line: Disabled

Tip: All setup and configuration settings are stored in the Up Software, not on the Up
Printer. This means that, if you change to a different computer, you will need to
repeat all the calibration and setup procedures.
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4. Printing

Please ensure the following points are taken care of before printing:

€ Connect the 3D printer, and set up the printing system. Load the model and place
it properly on the virtual platform of the software window. Check if there is
enough material for the model (the software will, generally, tell you if there is not
enough material when you begin the print). If not, change the reel to a new one.

€ For large models (over 40mm2) results can be improved by preheating the build
platform. Click the “Preheat” option on the “3D Print” menu and the printer
begins to heat the platform.

€ Click menu “3D Print->Print”, and the print dialog box pops up. Choose
“Preferences” to set the printing parameters. Click “OK” to begin to print.

Print E]
3D Printer

Printer: ‘LMF‘ Prirter 41.0/108215 j Preferences

Status: Prepared for Printing

Options: 0.20mm , Loose Fill

Options

oK

Copyles: Quality: |Fire -
Marmal

[~ UnSolid Mode| r Cancel

Fine

Print Options:

Speed: Fine, Normal or Fast. This simply determines the speed at which the printer
moves. As a general rule, the slower you print, the better the quality of the parts. For
tall parts, running at Fast speed can be problematic as the printer can vibrate to the
extent that print quality is affected. For large surface area parts, the Fine setting can be
problematic as the printer takes longer to print the part and the corners are therefore
more likely to lift a little bit.

UnSolid Model: This function is useful for printing STI files that are not perfect. A
perfect STL file is a fully enclosed surface, with no holes in the surface skin, and no
overlapping surfaces. If your file is not perfect, this option should allow you to print it
anyway.

Tip: Once the print has started, you can unplug the USB cable from the printer. The
print job is stored in the printer’s internal memory, so the PC is no longer required
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5. Model Removal

1. When the model has finished printing, the printer will beep, and the nozzle and
platform stop heating.

2. Remove the printer platform from the printer by removing the 2 screws at the
bottom of the platform.

3. Gently slide the spatula under the model and slowly wiggle it back and forth to
pry loose the model. Remember to use gloves as the platform and model may still
be hot.

Tip: The model is easier to remove from the printer when it is still hot. If you want to
heat the platform before removing your model, use the “preheat” option from the
“3D Print” menu

CAUTION: It is strongly recommended that you do not remove the model
from the platform while it is still attached to the printer. If the model is
removed with a lot of force while the platform is still on the printer, the
mechanical structure of the printer may be damaged or its precision
affected.
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Removing Support Material

Video - removing the raft and the support material from objects safely
http://vimeo.com/18525405

Printed models are composed of two parts. One part is the model itself, and the other
part is the support material used to support any overhanging parts of the model.

The support material is the same physical material as the model material, but the
support material is printed at a much lower density. It is very easy to distinguish the
model from the support material so it is easy to remove.

Have a look at the teapot in the above pictures. The left picture shows the teapot with
support material removed, and the right picture shows the teapot with its support
material still attached.

The support material gets removed using a combination of tools. Some material can
easily be cracked off by hand. Support material close to the model is easier to remove

using tools such as wood carving chisels, long nose pliers, or wire cutters.

It takes some practice to get comfortable with removing support material, but it can
become quite an enjoyable and therapeutic task!
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CAUTION: The support material and the tools are sharp. Wear
@ gloves and safety glasses when removing the part from the printer.
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6. Maintenance

Changing the Material

€ First withdraw the leftover material from the printer. Initialize the printer and
choose “3D print->Maintain”. Click “Withdraw” and the system automatically
begins to heat the nozzle. When the nozzle reaches the correct temperature, the
printer will beep, and you can gently withdraw the material.

€ Place a new spool of material on the spool holder, and pull it through the filament
tube, until the material is about 10cm out of the tube, then insert it into the hole at
the top of the extruder head.

€ Select the “maintain” menu form the “3D Print” menu. Then press the “Extrude”
button in the “maintain” dialogue. After the printer nozzle has warmed up to
260°C, the printer will beep. Push the filament into the hole at the top of the
extruder head, with a little pressure, and the extruder will automatically extrude
material. The plastic thread squeezed out of the nozzle should be thin, bright

and smooth.
If the nozzle is blocked, remove the nozzle and clean it.
!
-
The extruder and platform are hot. Use gloves when working in this
() @ area of printer.

Vertical Calibration

The Vertical calibration procedure allows you to ensure that the printer platform is perfectly

horizontal and that the printer prints consistently in the X, Y and Z direction.

First, print the supplied Calibration model on your printer. The calibration file is in C:\Program
Files\UP\Example.
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After the calibration model is printed, measure the X1 and X2 length, as shown in the pictures
below.

Open the “Calibrate” box form the “3D Print” menu and enter the measured X1 and X2 values
into the appropriate boxes.

Calibrate — XY¥: 0.0 Deg f ZX¥: 0.0 Deg

Front

Reset | Cancel |

Next, take down the Front Centre ‘L’ shaped component, and measure its deviation. Put the exact
value into the Z box. If it deviates to the right side, the value to be put into the Z box will be a
positive value. If the deviates to the left, the value to put into the Z box will be a negative value.
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Finally, measure the height of Front Center component, which should be 40mm if it is not scaled.

Enter the exact measured value into the “H” box of the “Calibrate dialogue box.

Click “OK” to record all these values and exit the calibration window.

Leveling the print platform

After you have correctly calibrated your nozzle height, check that the nozzle is at the same
distance at all four corners of the print platform. If it is not, you may need to adjust the platform
until it is level with the nozzle at all 4 corners. There are 3 screw and 3 spring washers under the

platform heater.

Loosen a screw and the related corner of platform will rise. Tighten, or loosen, the screws until

you have the same gap between the nozzle and the platform at all four corners of platform.

TIP: If you find it difficult to level the
platform, then remove screws 1,2 & 3. The
heater element has got 6 threaded holes. Use 3
screws for fixing the base to the heater
element, and another 3 to go in-between the
base and the heater element. Now you can
adjust the platform like a seesaw until you get

it level. Also ensure that the Extruder is level.
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Cleaning the nozzle

After a lot of printing, the nozzle may be covered with a layer of oxidized ABS. When
the printer is printing, this oxidized ABS may melt on the nozzle, and may create
discolored spots on the model. To avoid this you need to regularly clean the nozzle.

Clean the nozzle after a print has been completed so the oxidized ABS is easier to
remove. Lower the platform to the bottom on the “Maintain” dialogue box.

Lastly, use some heat-resistant material, like 100 percent cotton cloth or soft
/ o % paper. A pair of tweezers will also be required. Then clip paper or some other

heat-resistant things with tweezers to clean up the nozzle.

Cleaning the platform

If you are using the special green paint on your platform, the platform requires
cleaning after a few prints to get it back to a smooth surface. Simply remove the
platform from the machine and soak it in water for a few hours and the paint will peel
off easily.

Once clean, repaint it with the green paint, or cover it with blue masking tape.
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7.0. Tips & Tricks

Large parts can sometimes have their corners lift from the platform, which causes the
part to distort. This is caused by uneven heat across the surface of the platform.
Preheating the platform before beginning large parts is essential to minimize this
lifting. Also, the faster you can print such parts, the less lifting you are likely to get.
Some ways to increase print speed include:

e If possible, try to avoid printing such large parts in solid mode.

e Set the layer resolution to as high as you can get away with.

e Print the part in “Fast” mode.

Removing the screws that attach the print platform to the printer can be inconvenient.
This can be made much easier by printing little screw caps with handles on them that
get epoxied to the screw heads. This means the screws can then be removed without
the need for a tool. Files for the screw caps can be downloaded from:
http://www.thingiverse.com/thing:4113

After printing, use a fast drying epoxy glue to glue them onto the screws, Clamp the

screw and cap in a vice until the glue is dry to prevent the screw cap not sitting firmly
on the screw.
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8. Troubleshooting

Problem or error
message

Solution

No power

Verify power cord is securely plugged in.

Extruder or platform
fails to reach operating
temperature

1. Verify printer has initialized. if not, initialize the
printer

2. Heater is damaged, replace the heater

Material not extruding

Material is stuck in the extruder. See 3.3.3 Maintain
(Extrude)

The gap is too wide between the bearing and wire feed
rollers.

Cannot communicate
with printer

1. Make sure the USB cable is connected to the printer,
and to the PC

2. Unplug the USB cable, then plug in again.

3. Reset the printer—power off then power on.

4. Restart the PC

Others

Contact Technical Support : Support@pp3dp.com or
support@3DPrintingSystems.com
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